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1. Algemene informatie 

1.1 Symbolen in de gebruiksaanwijzing 
 

 

LET OP! 
Lees de gebruiksaanwijzing 

 

LET OP! 
Risico op een elektrische schok 

 

 
Dubbele isolering 

 

Toepassing in de buurt en demontage van gevaarlijke stroomvoerende geleiders is 
toegestaan 

 

Aarde 

 
AC (wisselstroom) 

 
DC (gelijkstroom) 

 
Gelijk- en wisselstroom 

 

Voldoet aan de Europese richtlijnen 

 

Gooi de multimeter niet bij het huishoudelijk afval. 
Lever deze in bij een inzamelpunt. 

 

 

1.2 Overspanning categorieën 
 
CAT I: Apparaten die zijn aangesloten op circuits waarin maatregelen worden getroffen om vluchtige 
overspanningen te beperken tot een laag niveau. 
CAT II: Eenfase lasten die zijn aangesloten op het stopcontact, waaronder onder andere 
huishoudelijke apparaten, draagbaar gereedschap en soortgelijke lasten. 
CAT III: Driefasen verdeling waaronder eenfase commerciële verlichting van o.a. apparaten in vaste 

installaties, zoals schakelapparaten en meerfasige motoren.  
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1.3 Veiligheid 
 
Lees deze gebruiksaanwijzing zorgvuldig en volledig door voordat u het apparaat voor het eerst in 
gebruik neemt.   

 Gebruik de power analyzer nooit voor spanningen> 600V 

 Grijp niet over de bovenste rand van de klem 

 Maak geen gebruik van de klemmen of de accessoires wanneer deze beschadigd zijn 

 Werk voorzichtig met de hoge spanningen 

 Werk voorzichtig bij metingen van> 30 VAC RMS of bij metingen> 60VDC 

 Ga uiterst voorzichtig te werk bij open leidingen en rails 

 Gebruik het meetapparaat alleen zoals beschreven staat in de gebruiksaanwijzing 
 
LET OP: Als u niet de meetkabels niet gebruikt zoals beschreven door de fabrikant, is de veiligheid 
niet meer gegarandeerd bij het meten. 
 

2. Functies 
 

 Vermogensanalyse in een enkele en symmetrische 3-fasen systeem 

 Analyse van de stroom en spanning 

 True RMS meting van de spanning met een nauwkeurigheid van 0,5% 

 True RMS meting van stroom met een nauwkeurigheid van 1% 

 Grafische weergave van stroom en spanning in een grafiek 

 Grafische vectordiagram 

 Detectie en opslag van in-, uit- en tussen trillingen 

 Actief (W, KW, PS), reactief (VAR, KVAR) en schijnbaar vermogen (VA, KVA) 

 Vermogen factor (cos φ), faseverschuiving (φ) en energie (Wh, kWh, KVARh) 

 Meting van de symmetrische 3 φ vermogenskwaliteit 

 Programmeerbare V/t verhouding van 1 tot 3000 

 Hold-functie 

 Automatische uitschakeling na 15 minuten (selecteerbaar) 

 Gegevensopslag en downloaden naar uw computer 

 Optische verbinding tussen het meetinstrument en de USB-kabel 

 Onbeperkte mogelijkheden voor het opslaan van meetgegevens op de computer 
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3. Apparaatomschrijving  

 
1. Stroomtang 
2. Hendel om de stroomtang te openen 
3. HOLD / CANCEL / Backlight- Met deze knop kan de display bevroren worden of de 

achtergrondverlichting in- of uitgeschakeld worden. Daarnaast kan de knop ook gebruikt 
worden om de boven- en ondertonen te wissen. 

4. Selectieknop - Gebruik de selectieknop om de meetmethode te kiezen. 
5. LCD - puntmatrix display met achtergrondverlichting 
6. + ► knop - waarde met 1 verhogen / referentie- as naar boven verschuiven / cursor naar 

rechts  verschuiven / pagina verder, naar het volgende punt 
7. REC - Druk op deze knop om de data-opname te starten. Druk nogmaals op deze knop om te 

stoppen. Houd de knop ingedrukt en zet het apparaat aan om meerde gegevens gelijkertijd 
te wissen. Bovendien kun u hiermee verdere configuraties uitvoeren. 

8. - ◄ knop - waarde met 1 verminderen/ referentie- as naar beneden verschuiven/ cursor naar 
links verschuiven / een pagina terug, naar het vorige punt 

9. FUNC knop- Druk op deze knop om naar een andere weergave te gaan. 
10. V- Ingang - Ingang voor voltage 
11. COM Ingang- Aarde- of referentie-ingang 
12. RS232-venster en batterijdeksel 
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4. Gebruiksaanwijzing  

4.1 Instellingen 
Draai de selectieschakelaar in de SETUP stand. U moet de instellingen voor de meting aanpassen. 

 
 

4.1.1 Instellingmogelijkheden in het SETUP menu 

 CURRENT TIME: Instellen van de huidige tijd voor de interne 
agenda (H: MM) 
SAMPLE: instelling voor de gegevensopname in seconden 
START TIME: Instellen van de tijd voor het starten van de 
gegevensregistratie (H: MM) 
STOP TIME: Instellen van de tijd voor het stoppen van de 
gegevensregistratie (H: MM) 
VT: Instellen van de meetconversie verhouding (standaard: 1) 
V (uitleg) = Spanning * VT 
MD: De MD (Maximum Demand) tijd ligt tussen 1 en 60 
minuten. Als de tijdsinterval is ingesteld, berekent het 
apparaat het maximale stroomverbruik en het gemiddelde 
stroomverbruik in Watt (W) of VA. 

HZ: Instellen van de netfrequentie (50Hz, 60Hz of auto) 
AUTO POWER OFF: Automatische uitschakeling AAN (1) of UIT (0) 
TRANS REF: Instellen van de nominale spanning en de drempel (%) voor de opname van trillingen. 
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HARMONICS CONFIG: Instellen van de boven- of 
ondergolven (harmonischen) die opgenomen dienen 
te worden. 

 
 
 
 
 
 
 
 

 
 
 
Opmerking: Het meetinstrument past de herhalingstijd aan op het ingestelde aantal trillingen. 
    

WAVEFORM CONFIG: Stelt hoeveel punten 
moeten worden opgenomen bij elke passage 
van de trilling indicator. Vier opties kunnen 
worden ingesteld: 32, 64, 128, 256 
 
Opmerking: meetinstrument past de 
herhalingstijd aan op het ingestelde aantal 
trillingen.  

  

Golven wissen 

Golven toevoegen 

Golven selecteren 
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DATE: de mogelijkheid om de huidige datum van de interne agenda 
van het systeem in te stellen. 
Formaat: YY: MM: DD 

 

 

 

 

4.2 Meting van de RMS waarde, THD-F en de bovenste / onderste golven van 

wisselspanning 

 

4.2.1 Spanningsmeting 

a. Zet de selectieschakelaar op de "V" – positie. 
b. Verbind de meetkabels met de overeenkomstige aansluitingen op de meter (zie 

foto). 
c. Houd de sensoren parallel aan de contacten die u wilt meten. 

 
Opmerking: Als de piekspanning, van de te meten spanning, het meetbereik overschrijdt verschijnt 
de melding "OL " op het display. 
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V1: waarde bij nominale frequentie (50Hz / 60Hz) 
V2: waarde bij 2. trilling 
... 
V50: waarde bij 50. trilling 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Opmerking: De frequentie wordt op de tweede zijde aangetoond (trillingen van 25 tot 50). 
  

 % THD-F: Absolute vervorming van de 
harmonischen ten opzichte van de 
fundamentele frequentie. 
 

 

RMS waarde 

Trilling 
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4.3 Meting van de RMS waarde, THD-F en de bovenste / onderste golven van 

wisselstroom 

 
 

4.3.1 Stroommetingen 

a. Zet de selectieschakelaar op de "A" – positie 
b. Klem de tang, zoals afgebeeld, om de geleider. Let hierbij op de richting van de 

stroom. 
c. De gemeten waarde wordt weergegeven op de display. 

 

 

   
 

V1: waarde bij nominale frequentie (50Hz / 60Hz) 
V2: waarde bij 2. trilling 
... 
V50: waarde bij 50. trilling 

 % THD-F: Absolute vervorming van de 
harmonischen ten opzichte van de 
fundamentele frequentie. 
 

RMS waarde 

Trilling 
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Opmerking: De frequentie wordt op de tweede zijde aangetoond (trillingen van 25 tot 50). 
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4.4 Weergave van ACV en ACA met fasehoek in de lijndiagram 

4.4.1 Weergave van stroom en spanning met fasehoek 

Als u de ACV en ACA wilt bekijken in het diagram, is het noodzakelijk dat de tang rond de geleider 
geplaatst wordt (stroommeting) en de meetkabels parallel aan het contact te houden 
(spanningsmeting). 

 
 
    
 
 
 
 
 
 
 

Wanneer u de selectieschakelaar in de positie draait om de 
diagram weer te geven, toont het meetapparaat de spanning, 
de stroom en de fasehoek. 
 
 
 
 
 
Als u op de knoppen + ► of -◄ drukt kunt u de referentie- as 
voor de spanning naar boven of naar beneden bijstellen. 
 
Zo kunt u stroom en spanning gemakkelijk aflezen, zoals op 
de begeleidende foto. 
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4.4.2 Weergave van spanning (ACV) 

  
 

Druk op de FUNC knop om de vertegenwoordiging van de 
spanning met RMS waarde en piekwaarde weer te geven. 

 
 
 
 
 
 
 

4.4.3 Vertegenwoordiging van de stroom (ACA) 

  
   
 

Druk op de FUNC knop om de vertegenwoordiging van de 
stroom met RMS waarde en piekwaarde weer te geven. 
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4.5 Eenfase vermogenanalyse 

 
a. Zet de selectieschakelaar in de stand "1 Phase". 
b. Verbind de meetkabels parallel aan de verbruiker. 
c. Klem de tang om de geleider, die naar de verbruiker gaat. Let op de richting van de stroom. 

 
Opmerking: Als de piekwaarde van de spanning of stroom het meetbereik overschrijdt geeft de 
meter de code  "OL" weer. 
 
Opmerking: Als de VT verhouding niet 1 is wordt de weergegeven waarde gelijk aan de gemeten 
waarde (W, VA, VAR) vermenigvuldigd met VT. 
Voorbeeld: WLCD = Wmess * VT 
 

4.5.1 Meting van het vermogen (W) en de vermogensfactor (PF) 

 
 

4.5.2 Meting van het schijnbare vermogen (VA, KVA) en reactief vermogen (VAR, KVAR) 
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4.5.3 Meting van het afgenomen vermogen (kW, kVA) 

 
 
Let op: Voor deze meting dient u de automatische uitschakeling te deactiveren! 
 

4.5.4 Meting van energie (KWh, PFh, KVARh en KVAh) 

 
 
Let op: Voor deze meting dient u de automatische uitschakeling te deactiveren! 
 

4.5.5 Weergave als vectordiagram 

 
 

4.5.6 Weergave van de RMS waarde van stroom en spanning 
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4.6 Meting van een symmetrisch 3 fase netwerk 

 
a. Zet de selectieschakelaar in de stand "3 phase". 
b. Verbind de meetkabels parallel aan de spanningsbronnen tussen L1 en L3. 
c. Klem de tang om de geleider, die naar de gebruiker gaat. Besteed hierbij aandacht aan de 

stroomrichting. 
d. Druk op de FUNC toets om de volgende informatie te verkrijgen. 

 

4.6.1 Meting van het vermogen (W) en de vermogensfactor (PF) 

 
 

4.6.2 Meting van het schijnbare vermogen (VA, KVA) en reactief vermogen (VAR, KVAR) 
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4.6.3 Meting van het maximale vermogen (kW, kVA) 

 
 
Let op: Voor deze meting dient u de automatische uitschakeling te deactiveren! 
 

4.6.4 Meting van energie (actief) (KWh, PFh, KVARh en KVAh) 

 

 

 
 
 
 
 
 
Let op: Voor deze meting dient u de automatische uitschakeling te deactiveren! 

4.6.5 Weergave als vectordiagram 

 
 

4.6.6 Weergave van de RMS waarde van stroom en spanning 
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5. Registratie van spanning (RMS- waarde) en de bovenste / 

onderste golven 

5.1 Geplande opname 
a. Zet de selectieschakelaar in de "V" positie. 

 
b. Als u het volgende beeld te zien krijgt op het beeldscherm, drukt u op de REC- knop waardoor de 
gegevensregistratie begint met de, in de set-up ingestelde, herhaalfrequentie. 

 
Opmerking: De eerste RMS-waarde en de eerste trilling worden altijd geregistreerd. 
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c. Als u op de REC-knop drukt verschijnt het volgende op het beeldscherm: 

 
U heeft 8 seconden de tijd om de opname te annuleren, door de HOLD knop 2 seconden lang 
ingedrukt te houden. 
Wanneer de HOLD-toets niet wordt ingedrukt, wordt de opname gestart. Als de data-opname is 
gestart zal de LED knipperen naast de aansluitingen. 
 
De begin- en eindtijd kunt u instellen in het set-up menu.. 
 

5.2 Onmiddellijke data opname 
Druk twee keer op de REC-knop. 
De starttijd wordt automatisch ingesteld op de volgende minuut. 
De stoptijd is de huidige tijd, op de volgende dag. 

 

6. Registratie van stroom (RMS- waarde) en de bovenste / 

onderste golven 

6.1 Geplande opname 
a. Stelt u in het SETUP menu een begin- en eindtijd in. Stel de selectieschakelaar in op de  "A" positie. 
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b. Om de opname te starten drukt u op de REC knop. 

 
 

c. Als u op de REC-knop drukt verschijnt het volgende op het beeldscherm. U heeft 8 seconden 
de tijd om de opname te annuleren, door de HOLD knop 2 seconden lang ingedrukt te 
houden. 
Wanneer de HOLD-toets niet wordt ingedrukt, wordt de opname gestart. Als de data-
opname is gestart zal de LED knipperen naast de aansluitingen. 

 
De begin- en eindtijd kunt u instellen in het set-up menu. 

 

6.2 Onmiddellijke data-opname 
Druk twee keer op de REC-knop. 
De starttijd wordt automatisch ingesteld op de volgende minuut. 
De stoptijd is de actuele tijd, op de volgende dag. 
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7. Dataregistratie van spanning- en stroomdiagrammen 

7.1 Registratie van de stroom- en spanningskarakteristiek 
Zet de selectieschakelaar in de positie voor de weergave van stroom- en spanningdiagrammen. Druk 
op de FUNC toets tot de golven van stroom en spanning worden weergegeven op de display. Druk op 
de REC-knop om te beginnen met de data-opname. Nu worden de stroom en de spanning 
geregistreerd. 
 

 
 
 
Opmerking: Het aantal opnamepunten kan worden ingesteld in het set-up menu. 
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7.2 Registratie van de spanningskarakteristiek 
Zet de selectieschakelaar in de positie voor de weergave van stroom- en spanningdiagrammen. Druk 
op de FUNC toets tot op de display de spanning as zichtbaar is. Druk op de REC-knop om te beginnen 
met de data-opname. 
 

 
 
Opmerking: Het aantal opnamepunten kan worden ingesteld in het set-up menu. 
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7.3 Registratie van de spanningskarakteristiek  
Zet de selectieschakelaar in de positie voor de weergave van stroom- en spanningdiagrammen. Druk 
op de FUNC toets tot op de display de spanning zichtbaar is. 
Druk op de REC-knop om te beginnen met het opnemen van de gegevens. 
 

 
 

Opmerking: Het aantal opnamepunten kan worden ingesteld in het set-up menu. 
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8. Dataregistratie van schommelingen door storingen 
Zet de selectieschakelaar op "Transient". Op de display wordt het volgende weergegeven: 
 

 
 

Nu wordt de referentiespanning (TRANS REF) van 110V met een drempelwaarde van 5% 
weergegeven. Wanneer de spanning hoger is dan 115,5V (SWELL) of lager is dan 104,5V (DIP) of 40V 
(OUTAGE) wordt er een storing geregistreerd. 
 
Opmerking: U kunt een maximum van 32.000 registreren. 
 
Druk op de FUNC knop om de registratie van schommelingen door storingen te starten. 
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Nadat u op de FUNC-knop gedrukt heeft, wordt de display leeg en de LED naast de aansluitingen zal 
beginnen te knipperen. 
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Om de opname te stoppen drukt u nogmaals op FUNC knop. Met behulp van de + ► of -◄ is het 
mogelijk om heen en weer te schakelen tussen de individuele registraties. 
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9. Gegevensregistratie vermogen 

9.1 Geplande opname 
Stel de selectieschakelaar in op 3 PHASE. Druk eenmaal op de REC-knop om de opname te starten. 
Stel vooraf de begin- en eindtijd in, via het set-up menu. 
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Wanneer de REC knop wordt ingedrukt zal de volgende weergave verschijnen. 
 

   
 
 
U heeft 8 seconden de tijd om de opname te annuleren wanneer u de HOLD knop 2 seconden 
ingedrukt houdt. 
Wanneer de HOLD-toets niet ingedrukt wordt, wordt de opname gestart. Als de data opname is 
gestart zal de LED naast de aansluitingen beginnen te knipperen. 
 

 
 
Het meetapparaat kan max. 50.000 waarden registreren (datum/tijd, VA, W, VAR, PF, KVAH, KWH, 
KVARH, PFH, AD (VA), AD (W), MD (VA), MD (W) fase, PS). 
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9.2 Onmiddellijke gegevensopname 
Druk twee keer op de REC-knop. 
De starttijd wordt automatisch ingesteld op de volgende minuut. 
De stoptijd is de actuele tijd, op de volgende dag. 
 

10. Wissen van het interne geheugen 
Om het geheugen van de datalogger te wissen, houdt u de REC-knop ingedrukt, en schakelt u het 
apparaat in. Druk op de HOLD knop om het wissen van het geheugen te bevestigen. 
Als het interne geheugen volledig gewist is, wordt het apparaat automatisch uitgeschakeld. 
 

 
 

Wanneer u de HOLD knop minder dan 8 seconden ingedrukt houdt wordt het geheugen niet gewist. 
Hierdoor kan het voorkomen worden dat het geheugen onbedoeld gewist wordt. 
 

11. RS232-protocol 
Baud Rate: 9600 
Databits: 8 
Stopbits: 1 
Pariteit: Geen 
Formaat: ASCII 
 

12. Specificaties (23 °C ± 5 °C) 

12.1 Vermogen 
Vermogen (50 of 60 Hz, PF 0,5 tot 1,0, VT = 1, voltage> 5V AC, stroom> 5A AC in A Bereik, en 
voortdurende trillingen) 
 
Bereik (0 tot 1500 A) Resolutie Nauwkeurigheid van de meting * 

>20V en >20A <20V of <20A 
10.0-999.9 W 0.1W ±1% ± 20dgts ±2% ± 40dgts 
1.000-9.999 KW 0.001 KW ±1% ± 20dgts ±2% ± 40dgts 
10.00-99.99 KW 0.01 KW ±1% ± 20dgts ±2% ± 40dgts 
100.0-999.9 KW 0.1 KW ±1% ± 20dgts ±2% ± 40dgts 
1000 - 9999 KW 1 KW ±1% ± 20dgts ±2% ± 40dgts 
 
* Bij VT ≠ 1, is de resolutie in procenten hetzelfde (± 1%). De extra indicatie van het vermogen moet 
met VT vermenigvuldigd worden, zoals bijvoorbeeld: ± 0.2W wordt ±0.2W * VT 
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12.2 Schijnbaar vermogen 
Schijnbaar vermogen (VA van 0.000VA tot 9999 KVA, PF 0.5 tot 1) 
Bereik (0 tot 1500 A) Resolutie Nauwkeurigheid van de meting * 

>20V en >20A <20V of <20A 
10.0-999.9 VA 0.1VA ±1% ± 20dgts ±2% ± 40dgts 
1.000-9.999 KVA 0.001 KVA ±1% ± 20dgts ±2% ± 40dgts 
10.00-99.99 KVA 0.01 KVA ±1% ± 20dgts ±2% ± 40dgts 
100.0-999.9 KVA 0.1 KVA ±1% ± 20dgts ±2% ± 40dgts 
1000 - 9999 KVA 1 KVA ±1% ± 20dgts ±2% ± 40dgts 
* Bij VT ≠ 1, is de resolutie in procenten hetzelfde (± 1%). De aanvullende indicatie van het vermogen 
moet met VT vermenigvuldigd worden, zoals bijvoorbeeld: ± 0.2VA wordt ±0.2VA * VT 
 

12.3 Reactief vermogen 
Reactief vermogen (VAR van 0.000 VAR tot 9999 KVAR) 
Bereik (0 tot 1500 A) Resolutie Nauwkeurigheid van de meting * 

>20V en >20A <20V of <20A 
10.0-999.9 VAR 0.1VAR ±2% ± 30dgts ±3% ± 40dgts 
1.000-9.999 KVAR 0.001 KVAR ±2% ± 30dgts ±3% ± 40dgts 
10.00-99.99 KVAR 0.01 KVAR ±2% ± 30dgts ±3% ± 40dgts 
100.0-999.9 KVAR 0.1 KVAR ±2% ± 30dgts ±3% ± 40dgts 
1000 - 9999 KVAR 1 KVAR ±2% ± 30dgts ±3% ± 40dgts 
* Bij VT ≠ 1, is de resolutie in procenten hetzelfde (± 1%). De aanvullende indicatie van het vermogen 
moet met VT vermenigvuldigd worden, zoals bijvoorbeeld: ± 0.2VAR wordt ±0.2VAR * VT 
 
Bereik van VT (Volt Transformator) Ratio: 1 tot 3000. 
 
Energy (werk) (WH of KWH van 0 WH tot 999.999 kWh) 
Berekening: WH = W * Tijd (in uren) 
 

12.4 Stroom 
Stroom (50 of 60 Hz, Auto Range, True RMS Piekfactor <4 bescherming tegen overbelasting 2000A) 
Bereik Resolutie Nauwkeurigheid van de meting 
4.0-1500.0 A 0.01 A ± 1.0% ± 5dgts 
 

12.5 Spanning 
Spanning (50 of 60 Hz, Auto range, True RMS Piekfactor <4, VT = 1, Ingang impedantie 10Ω, 
bescherming tegen overbelasting 800V) 
Bereik Resolutie Nauwkeurigheid van de meting * 
4.0 V - 600.0 V 0.1 V ± 0.5% ± 5dgts 
* Bij VT ≠ 1, is de resolutie in procenten hetzelfde (± 1%). De extra indicatie van het vermogen moet 
met VT vermenigvuldigd worden, zoals bijvoorbeeld: ± 0.2dgts wordt ±0.2dgts * VT 
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12.6 Bovengolven in de spanning in procenten 
Bovengolven in de spanning in procenten (1 tot 50 order, minimale spanning bij 50 Hz of 60 Hz> AC 
80V. Als de spanning bij 50Hz 0V bedraagt, wordt er 0 procent getoond. 
Bereik Resolutie Nauwkeurigheid van de meting 
1 - 20th 0.1% ± 2% 
21 - 50th 0.1% ±4% van de aflezing ± 2.0% 
 

12.7 Bovengolven in de spanning als absolute waarde 
Bovengolven in de spanning als absolute waarde (1 tot 50 order minimale spanning bij 50 Hz of 60 
Hz> 80V, VT = 1) 
Bereik Resolutie Nauwkeurigheid van de meting 
1 - 20th 0.1% ± 2% ± 0.5V 
21 - 50th 0.1% ±4% van de aflezing ± 0.5V 
 

12.8 Bovengolven in stroom in procenten 
Bovengolven in stroom in procenten  (order 1 tot 50, minimale stroom bij 50 of 60 Hz > 20A. 
Wanneer de stroom bij 50Hz 0A bedraagt wordt er 0% aangetoond. 
Bereik Resolutie Nauwkeurigheid van de meting 
1 - 20th 0.1% ± 2% 
21 - 50th 0.1% ±4% van de aflezing ± 2.0% 
 

12.9 Bovengolven in stroom als absolute waarde 
Bovengolven in stroom als absolute waarde (order 1 tot 50, minimale stroom bij 50 of 60 Hz> 20A) 
Bereik Resolutie Nauwkeurigheid van de meting 
1 - 20th 0.1% ±2% van de aflezing ± 0.4A 
21 - 50th 0.1% ±4% van de aflezing ± 0.4A 
 

12.10 Vermogensfactor 
Vermogensfactor (PF) 
Bereik Resolutie Nauwkeurigheid 
  > 20 V en> 20A <20V of <20A 
0.000-1.000 0.001 ± 0.04 ± 0.1 
 

12.11 Fasehoeken 
Fasehoeken (Φ) 
Bereik Resolutie Nauwkeurigheid 
-180 ° - 180 ° 0.1 ° ± 1 ° 
0 ° - 360 ° 0.1 ° ± 1 ° 
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12.12 Trillingstoringen 
Trillingstoringen (THD-F, in overeenstemming met de 50 of 60 Hz min. waarde bij 50 of 60 Hz> 80V 
en> 20 A, 1 tot de 50ste trillingen. Wanneer de stroom of de spanning bij 50Hz of 60Hz 0 is wordt 0% 
weergegeven. 
Bereik Resolutie Nauwkeurigheid 
0.0-20% 0.1% ± 2% 
20.1-100% 0.1% ± 6% van de aflezing ± 1% 
100.1-999.9% 0.1% ± 10% van de aflezing ± 1% 
 

12.13 Waarde van de piekspanning van stroom en spanning 
Waarde van de piekspanning (piekwaarde> 10V) of piekstroom (piekwaarde> 20A) 
Bereik Resolutie Nauwkeurigheid 
50 Hz 39 μs ± 5% ± 50 cijfers 
60 Hz 33 μs ± 5% ± 50 cijfers 
 
Frequentie (RMS-waarde> 20V) of ACA (RMS waarde> 30A) 
Bereik Resolutie Nauwkeurigheid 
46-65 0.1 ± 0.3Hz 
 
Alleen voor gebruik binnenshuis! 
 
Leiding grootte ca. Ø 55 mm, 65 x 24 mm (rails) 
Type batterijen 2 x AA 1.5V 
Beeldscherm 128 X 64-matrix LCD beeldscherm met achtergrondverlichting 
Meetbereik selectie Automatisch 
Overbelastingsindicatie OL 
Stroomverbruik Ongeveer 10 mA 
Automatische uitschakeling 15 min. na het inschakelen 
Updatetijd 2 herhalingen/seconde (display) 
Aantal meetherhalingen 512 (spanning of stroom) 

256 (vermogen) 
Bedrijfstemperatuur -10 oC tot 50 oC 
Maximale luchtvochtigheid Maximaal 85% relatief 
Gebruikshoogte Tot 2000 meter 
Opslagtemperatuur -20 oC tot 60 oC 
Opslag luchtvochtigheid Minder dan 75% relatief 
Afmetingen 271 mm (L) x 112 mm (B) x 46mm (H) 
Gewicht 647g incl. batterijen 
Accessoires Meetkabels  

Opbergtas 
Gebruiksaanwijzing 
Software gebruikshandleiding 
Software  
Batterijen AA 1.5V x 2 
Alligator klemmen 
RS232 - USB adapter 
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13. Vervangen van de batterij 
Het batterijniveau wordt weergegeven op het beeldscherm. 
 

 
 

 
 
Wanneer u de batterijen vervangt gaat u als volgt te werk: 

a. Schakel het apparaat uit en verwijder de meetkabels van het meetapparaat 
b. Verwijder de schroeven van het batterijvakdeksel 
c. Verwijder het batterijvakdeksel 
d. Verwijder de oude batterijen uit het compartiment 
e. Druk op de FUNC knop om restspanningen uit het apparaat te laten 
f. Plaats de nieuwe batterijen 
g. Plaats de deksel weer terug en draai de schroeven vast 

 

14. Onderhoud en reiniging 
Onderhoudswerkzaamheden en reparaties die niet in deze gebruiksaanwijzing worden beschreven, 
kunnen alleen worden uitgevoerd door opgeleid en gekwalificeerd personeel.  
Reinig de behuizing van het meetapparaat alleen met een vochtige doek en gebruik hiervoor geen 
schuurmiddelen of oplosmiddelen. 
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15. Software 

15.1 Operationele vereisten 
* PC met het besturingssysteem Microsoft Windows Vista / XP / 2000 (SP3) 
* NI-VISA motor dient geïnstalleerd te zijn (wordt automatisch geïnstalleerd tijdens de installatie van 
de software) 
* Passend USB besturingsprogramma dient geïnstalleerd te zijn (zie hoofdstuk 2) 
 

15.2 Hardware vereisten 
* PC met minimaal een 600 Mhz processor 
* Min.: 256 MB RAM aanbevolen: 512 MB of meer 
* Min. beeldschermresolutie van 1024x768 pixels 
 

15.3 Hoe aan te sluiten 
1) Zet het meetapparaat en de PC aan. 
2) Verbind het meetapparaat via de UBS-kabel met de computer. 
3) Start het programma van de Power analyzer. 
4) Selecteer de seriële poort waarop het apparaat is aangesloten. 
 

16. Software installatie 

16.1 Installatieprogramma 
Open het bestand setup.exe , van de bijgeleverde installatie cd-rom. Daarna start het 
installatieprogramma zelfstandig. Volg de instructies op het beeldscherm. 
 
Opmerking: 

 Nadat u de cd in uw cd-romstation heeft geplaatst zal deze automatisch opstarten 

 Wanneer het programma is geïnstalleerd, kunt u de computer opnieuw opstarten 
 

16.2 Installatie USB- driver 
Open het CP210x_VCP_Win2K_XP_S2K3.exe bestand op de installatie cd-rom, om de USB- driver te 
installeren. 
 
Opmerking: 

 Wanneer de hardware niet wordt gedetecteerd, verwijder dan de stekker uit de USB- poort 
en probeer het opnieuw. 
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17. Bediening van de software 

17.1 Starten van het programma 
Ga naar Start -> Programma's -> CLAMP-ON Graphic Power Quality Analyzer, om het programma te 
starten. 

Kiest u de poort uit waar het apparaat op aangesloten is en klik vervolgens op . 
Als u niet zeker weet welke poort dit is, kunt u dit bekijken in de Device Manager. 
 

 
 

17.2 Functies in het hoofdbeeldscherm 
Ga naar het hoofdbeeldscherm van de software. 

 
 

1) In de werkbalk vindt u functies zoals instellingen, de communicatie tussen de pc en het 
meetapparaat, downloaden van gegevens uit het meetapparaat, informatie en beëindigen. 

2) Systeem berichten worden hier getoond. 
 

17.3 Instelling van de parameters 
Klik in de werkbalk op File -> Setup, om de instellingen in te voeren. Zodra u de instellingen in het 
programma gemaakt heeft worden deze opgeslagen in het geheugen van het meetapparaat. 
 

17.3.1 Tijd en datum 
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Klik hier om de datum en de tijd in te stellen. Klik vervolgens op  om de 
instellingen toe te passen. 
 

17.3.2 Datalogger instellingen 

Instellingsmogelijkheden voor de meetherhalingen (Sample), begin- en eindtijd (Start Time / Stop 
Time) en het aantal punten in de diagram (Waveform point). 
 

 
 

17.3.3 Systeeminstellingen 

Instellingsmogelijkheden voor: Voltage Transformator (VT), referentie spanning voor storing 
spanningen (TRANS REF) en het bereik hiervan (%), frequentie (Hz), Demand Time (MD) en 
automatische uitschakeling (Auto Power Off). 
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17.4 Communicatie 
Klik op "Communicatie" om naar het beeldscherm van de communicatie te gaan. Om met het 
apparaat te kunnen communiceren moet het meetbereik op 3 fase, 1 fase, V, A of VA ingesteld 
worden. 

 
 

In de werkbalk, kunt u kiezen welke functie u wilt gebruiken. Gegevens openen (Open), opslaan van 
gegevens (Save), Gegevens sluiten (Close), ophalen van de tijd en de herhalingfrequentie(MD Time & 
Sample Rate), Print Screen (Print), als grafiek weergeven (Waveform) en beëindigen (Exit). 
 
Weergegeven wordt de actuele tijd (Current Time), starttijd (Start Time), Voltage transformator (VT), 
frequentie (Hz), Demand Time (MD), herhalingfrequentie (sample rate), het aantal opnames (Sample 
Count), en welke meetgegevens momenteel worden weergegeven (Present Sample). 
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17.5 Downloaden van data 
Klik op  Datalogger -> Down Load data (Ctrl+D) om de gegevens van het meetapparaat te laden. 
 

 
Er wordt aangegeven hoeveel procent reeds gedownload is. 
Klik op Reset om de download te annuleren. 
 

17.6 Geheugen wissen 
Klik op Datalogger -> Clear Memory (Ctrl + C) om naar het beeldscherm voor het wissen van de 
gegevens te gaan. 
 

 
 

Bevestig met "Clear Memory" om het geheugen te wissen. 
 
Waarschuwing: Gegevens die verwijderd zijn van het meetapparaat kunnen niet worden hersteld! 
Wanneer u de gegevens nodig bent kunt u ze downloaden van het apparaat en opslaan op uw 
computer (hoofdstuk 4.5), alvorens u het geheugen wist. 
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18. Communicatie met het apparaat 
De software laat zien welke gegevens momenteel op de display van het meetapparaat weergegeven 
worden. Wanneer u op de FUNC knop drukt kunt u selecteren welke gegevens weergegeven dienen 
te worden. 
 

18.1 Communicatiebeeldscherm 1 
Stelt u de schakelaar van het meetapparaat in op positie "3 fase" of "1 fase" en klik aansluitend op 
"Communicatie" om het communicatiebeeldscherm 1 te openen. 
 

 
 

1) Weergave van schijnbaar vermogen (S), actief vermogen (P) en reactief vermogen (Q) 
2) Weergave van het gemiddelde verlies en het maximale verlies 
3) Weergave van vermogensfactor (PF), PFF, fasehoek, vermogen in paardenkracht (HP) 

 

18.2 Communicatiebeeldscherm 2 
Zet de selectieschakelaar van het meetapparaat in de "V" positie en klik aansluitend op 
"Communicatie" om het communicatiebeeldscherm 2 te openen. 

 
1) Vertegenwoordiging van de spanningscurve 
2) Vertegenwoordiging van het amplitude spectrum 
3) Vertegenwoordiging van trillingen (selecteerbaar) 
4) Weergave van de huidige RMS, piek (Peak) en THD waarden  
5) Weergave van sterkte en van percentage 
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18.3 Communicatiebeeldscherm 3 
Zet de selectieschakelaar van het meetapparaat in de "VA" positie en klik aansluitend op 
"Communicatie" om het communicatiebeeldscherm 3 te openen. Nadat u de meting van stroom en 
spanning doorgevoerd heeft verschijnt de onderstaande weergave op het beeldscherm: 

 
 

1) Weergave van de spanning- en stroomkarakteristiek 
2) Weergave van huidig vermogen (P), schijnbaar vermogen (S) en fase 

 

18.4 Communicatiebeeldscherm 4 
Zet de selectieschakelaar van het meetapparaat in de "VA" positie en klik aansluitend op 
"Communicatie" om het communicatiebeeldscherm 4 te openen.  Nadat u de spanningsmeting 
doorgevoerd heeft verschijnt het onderstaande op het beeldscherm: 

 
 

1) Weergave van de spanningkarakteristiek 
2) Weergave van de actuele RMS en piek (Peak) waarden 
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18.5 Openen en opslaan van meetgegevens 
U kunt de data van de communicatiebeeldschermen of gedownloade meetgegevens van het 
meetapparaat opslaan. Om dit te doen, klikt u op File-> Save (Ctrl + S), de actuele gegevens worden 
vervolgens opgeslagen als CSV- bestand. 
 

 

18.6 Instellen van de MD- tijd en de herhalingfrequentie 
Klik op File -> MD Time & Sample Rate en klik aansluitend op "Setting". 
 

 
 

Het volgende scherm verschijnt: 
 

 
 

U heeft nu de mogelijkheid om de parameters te wijzigen. Klik op de Enter knop om de instellingen te 
bevestigen. 
 
Opmerking: Opgeslagen data zal verloren gaan door de bevestiging. Sla de gegevens op, voordat u de 
MD tijd en herhalingfrequentie verandert. 
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18.7 Printer selecteren 
Klik op File-> Print. Klik vervolgens op "▽" om de juiste printer te selecteren. 
 

 
 

18.8 Golfvorm 
Klik in het communicatiebeeldscherm op "Waveform" en selecteer  welke golfvorm u weergegeven 
wilt hebben. 
 
Communicatiebeeldscherm I: V, A, S, P, Q, PF, fase, KVAH, KWH, KVARH, PFH, VA (AD), W 

(AD), VA (MD), W (MD) 
Communicatiebeeldscherm II: RMS, Peak, THD 
Communicatiebeeldscherm III: V, A, P, S, fase 
Communicatiebeeldscherm IV: RMS, Peak 
 

18.9 Golfvorm actualiseren 
U kunt via het "Waveform-beeldscherm" handmatig het bereik en de cursorpositie veranderen om 
de meetwaarden nauwkeuriger in te stellen. Wanneer u dit onbedoeld heeft gedaan, kunt u dit als 
volgt ongedaan maken, om zo terug te keren naar de volledige grafiek. 
Klik op File-> Redraw en de grafiek wordt opnieuw weergegeven. 

 
 

1) Waarde van de huidige cursorpositie 
2) Weergave van de geselecteerde grafiek 
3) Verandering van de huidige cursorpositie 
4) Klik op de schaal om het gebied dat u wilt bereiken te verschuiven 

 

18.10 Printen van de golfvorm 
Klik op File-> Print om de huidig weergegeven golfvorm af te drukken. 
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18.11 Modi 
Real Time Modus: Geeft de huidige data weer in het communicatiebeeldscherm.  
History Modus: Voor het bekijken van eerder opgeslagen gegevens. Er kunnen nog steeds gegevens 
opgeslagen worden. 
File Modus: Hiermee opent u eerder opgeslagen bestanden van de computer. 
 

18.12 Resetten van de modi 
Ga naar View-> Reset. De gegevens (die momenteel worden getoond) verdwijnen van het 
beeldscherm en de software gaat in de Real Time Modus. 
 

 
 

1) Selecteren en resetten van de modi. 
2) Selectie van de weergegeven meetwaarden (alleen in de History Modus mogelijk) 
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19. Verwijdering en contact 
 

Batterijen mogen niet worden weggegooid bij het huishoudelijk afval; de eindgebruiker is wettelijk 

verplicht deze in te leveren. Gebruikte batterijen kunnen bij de daarvoor bestemde inzamelpunten 

worden ingeleverd. 

Bij vragen over ons assortiment of het meetinstrument kunt u contact opnemen met: 
 
PCE Brookhuis B.V. 
  
Institutenweg 15 
7521 PH Enschede 
The Netherlands 
 
Telefoon: +31 53 737 01 92   
Fax: +31 53 430 36 46   
 
info@pcebenelux.nl 
  
 
 
 
 
 
Een compleet overzicht van onze apparatuur vindt u hier: 
http://www.pcebrookhuis.nl/ 
https://www.pce-instruments.com/dutch/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
WEEE-Reg.-Nr.DE69278128 
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